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1 Introduction

The free FT9XX toolchain is a port from the popular GNU toolchain which includes the following
components:

e GCC based compiler
e ft32-elf-gcc (GCC) 8.0.0 20171111 (experimental)GNU Binary Utilities (binutils) based
tools, most notably:
o as - the assembler
o Id - the linker
o and some other useful tools such as objdump, ar, ranlib, addr2line, etc.
e GDB based debugger
e In addition, a plugin for the Eclipse IDE is also provided. This ‘Bridgetek FT9XX Eclipse
plugin’ allows the FT9xx toolchain to integrate seamlessly into Eclipse and as a result,
greatly simplify the development and debugging of applications for the FT9xx MCUs.

1.1 Compiler: ft32-elf-gcc

The FT9XX compiler is used similarly to standard GCC. It supports most GCC options such as -
Wall, -01, -02...

Example: To compile a C file into an object file:

ft32-elf-gcc -c -o file.o file.c

1.2 Assembler: ft32-elf-as

The FT9XX assembler functions in the same way as the standard GNU assembler (GAS). The
assembly files should be written using the GAS general syntax.

Example: To compile an assembly file into an object file:

ft32-elf-as -o file.o file.s

1.3 Linker: ft32-elf-Id

Typically running behind ft32-elf-gcc, the FT9XX linker performs two tasks. It first links all object
files and libraries into a.out and then convert’s a.out into an executable file for FT9XX. Similar to
the FT9XX compiler and assembler, the FT9xx linker supports most standard GNU linker options.

Example:
e To link various object files / libraries into an .elf file:
ft32-elf-gcc -nostartfiles filel.o file2.0 -L <libfolder> -l lib1 -I lib2 -o file.elf
e To convert file.elf into a FT9xx binary file, which can be programmed into the chips:

ft32-elf-ld --oformat binary -o file.bin file.elf

1.4 Debugger: ft32-elf-gdb

The Bridgetek programmer/debugger module is needed for the communication between ft32-elf-
gdb and the chip. The communication follows the GDB remote protocol. In addition to the
debugger module, two software components are needed:

e GDB Bridge: for converting GDB commands into the debugger module commands
e Bootloader: for receiving & executing the debugger module commands
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More information on how to use the FT9xx debugger can be found in section 6.1.3 of this
document.

1.5 A useful utility: ft32-elf-objdump

ft32-elf-objdump displays various information about object files. Its usage is the same as standard
GNU objdump.

Example: To disassemble file.elf into a text file

ft32-elf-objdump -d file.elf > disassembly.txt
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2 Setting up the FT9XX Toolchain

2.1 Installing the Toolchain

The toolchain can be installed by running the setup wizard “FT9XX Toolchain Setup_version.exe”,
which can be downloaded from the Bridgetek website. Please follow the steps in the wizard to

complete the installation process. It is recommended to use the default settings for simplicity.

Note: all applications should be closed before the installation or a restart may be required.

4% FT%x Toolchain Setup

4 Bridgetek

ERIDGING TECHNOLOGY

-
.0
* )
-

Welcome to the FT9xx Toolchain Setup Wizard

This wizard will guide you through the installation of the FT9xx Toolchain.

It is recommended that you dose &ll other applications before continuing. This will make
it possible to update relevant system files without having to reboot your computer.

Click Mext to continue.

Mext = Cancel

Figure 1 Toolchain Setup Wizard Dialog box

In the License Agreement dialog box, click I Agree.

% FT9x Toolchain Setup

License Agreement

Flease review the license terms before instaling the FTSwx Toolchain.

(PSSR

Bridgetek

BRIDGING TECHNOLAGY

<

Press Page Down to see the rest of the agreement.

[FTQxx Toolchain Licensing Information

License.

License.

The Cwvowin T T < and lhraries are distribited nnder the GNTT GPT

GINU Binutils is distributed under the GNU GPL License.
GNU Compiler Collection (GCC) is distributed under the GNU GPL

GINU Debugger (GDB) is distributed under the GNU GPL License.

GINU Make and GNU Coreutils are distributed under the GNU GPL

-

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install the FT9xx Toolchain.

< Back

[ I Agree [ Cancel

Figure 2 License Agreement Dialog box
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Go through the Revision and Release information and click Next.

T, [ =]

ERIDGING TECHNOLOGY

Revision and Rel Inf ion 7 H
View information about the revisions of components induded in the FT9xx Toolchain. & ‘ B rl d g ete k
*
*
*

Press Page Down to see the rest of the Revision and Release Information.

Release Information

This is Release 2.3.1 of the FT9xx Toolchain for Windows,
comprising the command-line tools (GCC, GNU Binutils, GDB), the
Eclipse IDE and the drivers needed to start development. A set
of examples are included to demonstrate how to use the drivers.
Projects created with the Bridgetek Eclipse plugin are compiled
using a Makefile. Therefore, the latest version of some
necessary GnuWin32 utilities (make and coreutils) are also
included.

This toolchain adds support for the FT93@ series of
Microcontrollers.

Revision Information

This information can also be found in Release Notes. txt in your installation directory.

cms [ e

Figure 3 Revision and Release Information Dialog box

Select the Components and click Next. The toolchain has an option to install Python 2.7.10 (see
Fig 4). You may opt out of the Python installation, if Python 2.7.x or later is present in your
system, by unselecting the option for Python 2.7.10 in the Components Dialog box.

™ H b
FT9xx Toolchain Setup e~
Choose Components .o’ =
Choose which features of the FT9xx Toolchain you want to install. ‘.‘ B rl d g ete k

* ERIDGING TECHROLOGY

Check the components you want to install and unchedk the components you don't want to install.
Click Next to continue.

rDescription

Position your mouse aver a
component ko seg its
description.

Select components to install:

GruWin32 Make 3
GruWin32 CoreUt
Java 8 Update 12

MCCI USB Stack Tools
FTaxx Driver Library 5
FTax Example Applic:
Update PATH variable
Create icons on deskt

Space required: 736.9MB

Figure 4 Components Dialog box

Click Browse and select a different file path for the FT9XX Toolchain installation. Alternatively,
continue installing in the specified folder by clicking Next.
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The toolchain components like Eclipse IDE, GNU toolchain, programmer utility, FT900 library
headers and 3™ party library are installed in the selected path. If the specified path, which is a
system path under ‘Program Files’ or ‘Program Files (x86)’ is chosen, one has to be aware of
Virtual Store folders and files in the section 7.4.

[ & FT9 Toolchain Setup L2
Choose Install Location - -
Choose the folder in which to install the FT9xx Toolchain. * ‘ B rl d g ete k
*
*

ERIDGING TECHNOLOGY

Setup will install the FT9xx Toolchain in the following folder. To install in a different folder, dick
Browse and select another folder. Click Next to continue.

"Desﬁnaﬁon Folder

Space required: 591.3MB
Space available: 46, 2GB

s [ e

Figure 5 FT9XX Toolchain Install Location Dialog box

Click Browse and select a different file path for installing FT9XX examples and documents.
Alternatively, continue installing in the specified folder, by clicking Install.

Eo o L] .= o S|

Choose Install Location ’o’ -
Choose the folder in which to install the FT9xx Toolchain. ,.‘ B rl d g ete k
*
-

BRIDGING TECHNOLOGY

Flease select the installation folder for the FT9xx examples and documents,

: \Users\govind. mukundan \Documents \Bridgetek \FT9::40.0. 1

"Fl'gxx Examples and Documents Ir

Space required: 591.3MB
Space available: 46.2GE

| <meck || msml |

Figure 6 FT9XX Toolchain-Examples & Documents Install Location Dialog box
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The FT9XX Toolchain installation progress bar is displayed.
I Fro:c Toolchain Setup

*

Installing -~ -
Please wait while the FT9xx Toolchain is being installed. B rl d g ete k

*
.0. BRIDGING TECHNODLOGY

Extract: hashtable.h

Extract: thread... 100%

Extract: tuple... 100%

Extract: type_traits... 100%

Extract: typeindex... 100%

Extract: typeinfo... 100%

Extract: unordered_map... 100%
Extract: unordered_set... 100%
Extract: utility... 100%:

Extract: valarray... 100%

Extract: variant... 100%

Extract: vector... 100%

Qutput folder: C:\Program Files'Bridgetek\FT9xx Toolchain\Toolchaintools\ft32-elfindud. ..
Extract: auto_ptr.h... 100%

Extract: backward_warning.h... 100%
Extract: binders.h... 100%

Extract: hash_fun.h... 100%

Extract: hash_map... 100%

Extract: hash_set... 100%

Fvtrart hachtahla h

] L]

Figure 7 FT9XX Toolchain - Installation Progress Window

If Java is selected for installation, the following message is displayed. Please close any open Java
Applications and click OK.

ERIDGING TECHNOLOGY

Installing ’o’ B - d k
Flease wait while the FT9xx Toolchain is being installed. ,.‘ rl g ete
)
*

Extract: jre-8u121-windows-586.exe

nuWin32\sharelloca...
ouiin hareloca...

@ Setup will now run the Java Runtime (JRE) Installer. Please close any
W' open Java Applications (like Eclipse) before proceeding.

QOutput folder: C:\Program Files\Bridgetek \FT9xx Toolchain\External\GnuWin32\shareYoca. ..
Qutput folder: C:\Program Files\Bridgetek \FT9xx Toolchain\External\Gnuwin32

Qutput folder: C:\Program Files\Bridgetek \FT9xx Toolchain\External\Javag

Extract: jre-8u121-windows-586.exe

e )

Figure 8 Close any running Java Applications before launching JRE Installer

Setup will then launch the JRE installer and the following window will be displayed.
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*
,
el

.
‘, BRIDGING

*

-
Java Setup - Welcome

Welcome to Java

Java provides access to a world of amazing content. From business
solutions to helpful utilities and entertainment, Java makes your Internet
experience come to life.

Mote: Mo personal information is gathered as part of our install process
Click here for maore information on what we do collect.

Click Install to accept the license agreement and install Java now.

Install >

[ change destination folder [ Cancel l i
—
Figure 9 Java Setup Window

Click Install and follow the instructions to install Java on the machine.

.
Java Setup - Welcome

Installing Java

3 Billio
Devices Run Java
Java #1 Development Platform m

Status:

=
=

Figure 10 Java Setup Progress Window

During installation, if a Python 2.7.10 Setup dialog box is displayed, select the appropriate

option as required and click Next.
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3 Python 2.7.10 Setup

==

python

flll'
windows

Select whether to install Python 2.7.10
for all users of this computer.

() Install just for me (not availble on Windows Vista)

Back [ Mext > ] [ Cancel

Figure 11 Python Setup Dialog box

Select a different Destination Directory to setup Python. Alternatively, continue installing in the

specified folder by clicking Next.

Figure 12 Destination Directory Selection Dialog box for Python Setup

Select the Python features to be installed or continue with the default features and click Next.

4 Python 2.7.10 Setup

[

b

python
for
windows

Select Destination Directory

Please select a directory for the Python 2.7.10 files.

£ python27 -

|C:\Python27\,

- Back |f Next= ] [ Cancel |
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[ 48 python 2710 Setup )

Customize Python 2.7.10

Select the way you want features to be instaled.
Click on the icons in the tree below to change the
way features will be installed.

13

Register Extensions
T/ Tk
Documentation
Utility Scripts

pip .
Test suite

AAA mdbhmem maes s M=k

m

Python Interpreter and Libraries

python

for This feature requires 25MB on your hard drive. It
g has 6 of 7 subfeatures selected. The subfeatures
WIﬂd(JWS require 30MB on your hard drive.
[ Disk Usage ] [ Advanced ] [ < Back ][ Next = ] [ Cancel ]

Figure 13 Python Features Customization Dialog box

Python installation progress bar is displayed.

[ 15 Python 2.7.10 Setup e |

Install Python 2.7.10

Please wait while the Installer installs Python 2.7.10. This may take
several minutes.

Status: Copying new files

Figure 14 Python Installation Progress Dialog box
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Click Finish to complete the Python installation.

-
) Python 2.7.10 Setup

=

pgthfon
windows

Complete the Python 2.7.10 Installer

Special Windows thanks to:
Mark Hammond, without whose years of freely
shared Windows expertise, Python for Windows
would stil be Python for DOS.

Click the Finish button to exit the Installer.

< Back Cancel

Figure 15 Python Installation Completion Dialog box

The FT9XX Toolchain installation is continued.

ﬁm«ToolchaTnSem [

Installing

Please wait while the FT9xx Toolchain is being installed.

( Bridgetek

BRIDGING TECHROLOGY

Extract: structboms_ scsi_ c_r_b_ inquiry__t.himl

Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Extract:

Extract:

: structboms__scsi
Futrart:

structboms__command_block_wrapper__t.html... 100%
structboms__command_status_wrapper__t.html... 100%
structboms__scsi_ ¢ d_b_ inguiry__t.html... 100%:
structboms__scsi_ ¢ d_b_ mode_ sense_ t.himl... 100%
structboms__scsi_ ¢ d_b_ read_ capadty_ thtml... 100%
structboms__scsi___c_d_b_ read__format__capadty__t.html... 100%
structboms__ scsi_ ¢ d b read_ t.html... 100%
structboms__scsi_ ¢ d_b_ removal__t.html... 100%
structboms__scsi_ ¢ d_b_ request_ sense_ t.himl... 100%
structboms__scsi_ ¢ d_b_ test_ unit_ ready_ t.html... 100%

__c_d_b_ write_ t.html... 100%

rrh

aetriirthnme  arai imire bl

[ < Back H Next = ‘

Figure 16 FT9XX Toolchain - Installation Progress Window

Select the Open AN_325 checkbox to start immediately after closing the Setup Wizard

. Else leave

it unchecked. Click Finish to complete the FT9XX Toolchain Setup.
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“ FT9xx Toolchain Setup = )

< Bridgetek

TECHNOLOGY

Completing the FT9x Toolchain Setup Wizard

The FT9xx Toolchain Setup Wizard has completed successfully. Click Finish to exit the
Setup Wizard. A quick start guide for using the toolchain is induded in the application
notes AN_325. For more information, as well as the latest updates, please visit
Bridgetek's website at www.brtchip. com.

Finish Cancel

Figure 17 FT9XX Toolchain Setup Completion Dialog box

After the installation, the toolchain can be found in the installation directory. The default location is
“C:\Program Files\Bridgetek\FT9XX Toolchain” for 32-bit Windows and "“C:\Program Files
(x86)\Bridgetek\FTOXX Toolchain” for 64-bit Windows. This directory also contains the external
utilities needed. The FT9XX drivers, sample applications and documents (if selected for
installation) can be found in "My Documents\Bridgetek\FT9xx".

2.1.1 Installing Java Runtime Environment Manually

The Toolchain requires the Windows MSI Installer (msiexec.exe) while installing the Java Runtime
Environment (JRE). The MSI installer can only process one installation at a time. Under some
conditions, msiexec.exe may have already been started by another Windows process during
automatic Windows Update for example. If the installer detects another instance of msiexec.exe
running in the background, the user will be prompted to either wait for the background MSI
Installer to complete and retry after 5 seconds or to skip the JRE installation entirely. This is
shown in Figure 18.
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FT9x Toolchain Setup
Installing =
Please wait while the FT9xx Toolchain is being installed. ‘ B rl d g ete k
ERIDGING TECHNOLOGY
% FT%o Toolchain Setup . lﬁ"-‘

.-"'_"“-I Setup has detected another instance of Windows MSI Installer
WYY (msiexec.exe) running. Setup requires the Windows MSI Installer to
a install the Java Runtime Environment {(JRE) but it is unable to proceed
because msiexec.exe is already used by another process,

Click Yes to wait 5 seconds to retry JRE installation or Mo to skip. JRE
may also be installed separately from the following URL
http://www.oracle.com/technetwork/java/javase/downloads/jrel -dow
nloads-2133155.html

Please install the 32-bit version (jre-woce-windows-i5860.exe)

< Back I I Mext = Cancel

Figure 18 MSI Installer is busy

If the user skips JRE installation, JRE can be installed manually from the Oracle Website
(http://www.oracle.com/technetwork/java/javase/downloads/jre8-downloads-2133155.html) or by
re-running the FT9xx Toolchain Installer later. Please ensure to install the 32-bit version of JRE
(jre-xxx-windows-i586.exe) as the Eclipse installed as part of the FT9xx Toolchain install is 32-bit.

2.2 Verifying the installation

1. Open a Command Prompt window by typing "cmd” in *Windows Start button > Search box”.
2. Type “ft32-elf-gcc --version” in the command prompt. It should give the following message:

ft32-elf-gcc (GCC) 8.0.0 20171111 (experimental)

Copyright (C) 2017 Free Software Foundation, Inc.

This is free software; see the source for copying conditions. There is NO

warranty; not even for MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.

If this message appears, then the toolchain has been successfully setup.
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3 Quick Start Guide: From creating to getting your
application to run on the FT9XX MCUs

This Section guides you through the steps to create a new application, compile and program it into
the chip. To debug your application, please refer to Section 4 - “Setting up Eclipse for Debugging”.
For more information about the tools, as well as the advanced features, refer to Section 6 -
“Advanced Topics”.

3.1 Creating a new project
Double click on the icon “Eclipse for FTOXX" to launch the Eclipse IDE.

Figure 19 Eclipse for FT9XX Icon
When you run Eclipse for the first time, it will ask you for the location of the workspace. Eclipse

will create some files within this directory to manage the projects. Specify a folder of your choice
and click OK.

= Workspace Launcher ﬁ

Select a workspace

Eclipse stores your projects in a folder called a workspace,
Choose a workspace folder to use for this session,

Workspace: | - Browse...

[] Use this as the default and do not ask again

Figure 20 Eclipse Workspace Selection

Note: The following message will be displayed if an existing workspace, which was created by an
older version of Eclipse, is specified. As there may be some configurational changes in files related
to workspace in the newer version of Eclipse which may cause issues, it is recommended to create
a new workspace and import the existing projects to the new workspace.
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& Clder Workspace Version ﬁ

Workspace 'Ci/workspace’ was written with an older version of the product and will
be updated. Updating the workspace can make it incompatible with older versions of
the product.

Are you sure you want to continue with this workspace?

[] Do not warn again about workspace versions

oK

||

S ————————————————————————————

Cancel

Figure 21 Eclipse Workspace Update

To create a new C project in Eclipse, on the menu bar click “File > New > C Project”. The C
Project wizard will open.

Give a name to the project, for example “Hello World”. By default, the new project will be created
inside the workspace you have chosen. If you want to change it, uncheck the box “Use default
location” and specify another location. Choose “Empty Project” for the project type and
“"Bridgetek FT9XX GCC” for the toolchain. This ensures all the relevant FT9XX include files are
part of the project. Click Next.

&= C Project =NAEN X
C Project —
Create C project of selected type
Project name:  Helle World
Use default location
ChworkspaceHello World Browse

||
| default
| Project type: Toolchains:
4 [= Executable Bridgetek FT%ax GCC
I @ Empty Project Cross GCC
@ Hello World ANSI C Project Cygwin GCC

> [= Shared Library

> [= Static Library

> [= Others

> [= Makefile project
> [= GMNU Autotools

Show project types and toolchains only if they are supported on the platform

Cancel

FEinish

Figure 22 C Project Wizard

In the next window, select FT900 _* configurations if your project is to target FT900 series of MCU
or FT930_* to target FT930 series, or both if you wish to target both series and click Next.
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[ & ( Project (Sl S |

Select Configurations —

Select platforms and cenfigurations you wish to deploy on

Project type: Executable
Toclchains: Bridgetek FT%o GCC

Configurations:

| & FT900 Debug Select all
B3 FT900_Release

I 3 FT930_Debug Deselect all

%3 FT930_Release

I Advanced settings...

Use "Advanced settings” button to edit project's properties.

Additional configurations can be added after project creation.
Use "Manage configurations” buttons either en toolbar er on property pages.

I:?) I < Back H Mext = l Finish

-

Figure 23 Project Wizard - Build Configurations Selection

The last window is for the toolchain prefix and location. By default, the values will be prefilled as
follows.

FT9x compiler prefoe ft32-elf-
FT%¢ compiler path:  C:/Program Files (x86)/Bridgetek/FT%x Toolchain/Toolchain/tocls/bin

Figure 24 C Project Wizard - Toolchain Details

Click Finish to complete the New Project Wizard. A new FT9XX project will be created in Eclipse.

3.2 Building the project

After the wizard completes, some folders and an empty source file (main.c) will be created.

File Edit Source Refi
' i=<J> - | @ - 4
I Project Explorer &3

a|[=5 Hello World
> [ Includes
» = Includes
> 2= Scripts
4 = Sources
» LE| main.c

Figure 25 New empty project structure
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The main.c contains some default content:

#tinclude <stdint.h>
#tinclude <ft900.h>

#if defined(___FT900_ )
#tdefine GPIO_UARTO_TX
#define GPIO_UARTO_RX
#elif defined(__FT930_ )
#define GPIO UARTO_TX
#define GPIO UARTO_RX
#tendif

int main(void){

/* Enable the UART Device...
sys_enable(sys_device_uarto);

48
49

23
22

/* Set UARTO GPIO functions to UARTO_TXD and UARTO_RXD... */
gpio_function(GPIO_UARTO_TX, pad uarté_txd); /* UARTO TXD */
gpio_function(GPIO_UARTO_RX, pad _uart@ _rxd); /* UARTO RXD */

uart_open(UARTO,
1,

/*
/*

UART_DIVIDER_19200 BAUD, /*

uart_data_bits_8,
uart_parity none,
uart_stop_bits 1);

/*
/*
/*

/* Print out a welcome message... */

uart_puts(UARTO,

"Hello World! \r\n"

/* Now keep looping */

while (1);

return 0;

}

Device */

Prescaler = 1 */

Divider = 1302 */
No. Data Bits */
Parity */

No. Stop Bits */

Now select the Build Configuration for either FT90X or FT93X via the project menu:
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[Project | Run Bridgetek Utilities Window Help

Open Project v Q v @@ §F v : - -
Close Project

it

| log Build All Ctrl+B B

‘ Build Configurations 4 ‘ Set Active » | v 1FT900_Debug
Build Project Manage... | 2 FT900_Release
Build Working Set 4 Build by Working Set ’ 3 FT930_Debug
S Set Active by Working Set » S e

| ¥ Build Automatically

Manage Working Sets...

Build Targets >
C/C++ Index >
Properties

Figure 26 Build Configuration
This can also be done via the Manage Configurations toolbar icon:
S T R S
iv/ 1 FT900_Debug |
2 FT900_Release

3 FT930_Debug
4 FT930_Release

Figure 27 Build Configuration

Now the project can be built by clicking on the menu Project > Build Project, but note that

|

there are a few options like right-click on the project > Build Project and the icon.

Project | Run  Target Window Help
Open Project |
Close Project

J |y Build All Ctrl+B
Build Configurations r
1 Build Project

Figure 28 Building the Project

The console window at the bottom of the IDE shows the build status. If the build completes
successfully, two files will be created - “Hello World.elf” and “Hello World.bin”. The file to be
programmed into the chip is “Hello World.bin”. The .elf file is used for the debugger, as detailed in
the next Section.
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|2 Problems 4| Tasks & Console i | [C] Properties

CDT Build Conscle [Hello World]

15:52:13 **** Incremental Build of cenfiguration FT938_Release for project Hello World ****

make all

"Building file: ../Sources/main.c’

"Invoking: FT9xx GCC Compiler’

ft32-elf-gcc -D__FT93@__ -I"C:/Program Files/Bridgetek/FT9xx Tooclchain/Toolchain/hardware/include”™ -0s -Wall -c -fmessage-len;
"Finished building: ../Sources/main.c’

'Building target: Hello World.elf'

"Invoking: FT9xx GCC Linker'

ft32-elf-gcc -L"C:/Program Files/Bridgetek/FT9xx Toolchain/Toolchain/hardware/lib/Release™ -Wl,--gc-sectieons -WL,--entry=_sta:
'Finished building target: Hello World.elf’

"Inveking: FT9xx Flash File Generator'

ft32-elf-objcopy --output-target binary "Hello World.elf" “Helle World.bin™
"Finished building: Helle World.bin'

Figure 29 Build Status

&= workspace - C/C++ - Eclipse [ Project Explorer 53 = I
—

File Edit Source Refactor Navigate S = <-===5| =
Y |®vﬁvn1¢§‘ﬁ§:§ 4 |l=5 Hello World
. - - » g};gp' Binaries

I [mjt Includes

FT900_Deb

f[\jl:'rnject Explorer i3 = “ = --eeu

‘ + == Sources l

&Rl ~ . %5 Hello World.elf - [none/le]

4 |[=5 Hello World [E Hello World.bin
> qf,f' Binaries [ maketiie
> [nyt Includes | & objects.mk
= FT900_Debug

3 | sources.mk

: == FT900_Release 4 [= FT900_Release

: == FT930_Debug + == Sources
» [= FT930_Release v i_} Helle World.elf - [none/le]

. = Includes ™=\ [ Hello World.bin
> [= Scripts | @ makefile
s = Sources | & objects.mk
& sources.mk
4 = F1930_Debug
+ == Sources
» f‘;« Hello World. elf - [none/le]
[E Hello World.bin
@ makefile
| & objects.mk
& sources.mk
4 = FT930_Release

» (== Sources

» (2 Hello World.elf - [nonefle]
[E Hello World.bin
| @ makefile

| & objects.mk

A snnrces mb

Figure 30 List of Files after building (if all 4 configurations were selected)

For syntax highlighting to work correctly as configurations are switched, the C/C++ Indexer must
be configured to “work with the active build configuration”. Refer to section 6.3.3 for more details
on how to do this.
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3.3 Programming the binary file into the chip
There are two ways to program a binary image into the chip.

The debugger may be used to program the binary image into flash or program memory prior to
the start of a debug session. Alternatively, if debugging is not required, the FT9XX programmer
utility may be used to program the binary image to flash. Unlike the debugger sessions, the
programmer utility supports programming to flash memory only.

The programmer utility and Eclipse debugger both use the 1-wire interface to communicate with
the FT9xx. Therefore, the utility and debugger shall not be used at the same time.

3.3.1 Eclipse Plugin

The FT9XX toolchain components, including the FT9XX Programmer, have been fully integrated to
the Eclipse IDE to allow seamless debugging experience.

To program the compiled binary file into the chip, do the following:

1. On the Menu bar, select Run - Run Configurations...

2. In the Run Configurations window, expand the launch configuration type “FT9XX Application
Run” and select the default instance "FT9XX RUN".

3. Click on the ‘Run’ button to start the download. This will internally launch FT9XX Programmer
application. The Console window will show the progress of the download.

4. For succeeding run sessions, select Run - Run Last Launched.

(a.r IRun Last Launched I Ctrl+F11
*&3 Debug Last Launched Fi1
‘8- Profile Last Launched

Profile History b
Profile s k

Profile Configurations...

Run History »
Fun &5 J
IRun Configurations... I

Debug History »
Debug &5 b
Debug Confiqurations..,

Toggle Breakpoint Ctrl +Shift+B
Toggle Line Breakpoint
Toggle Method Breakpoint
Toggle Watchpoint

& Skip All Breakpoints Ctrl + At +B
Rerrove &l Breakpoints

Breakpoint Types b

cﬁ, External Tools k

Figure 31 Run menus - Run Configurations and Run Last Launched
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(& o Corigurations TR O B

>

| Create, manage, and run configurations

BX|BE®- Name: FToXX RUN

| [ Main ] Commen
[E] C/C++ Application
[C] C/C++ Remote Application

4 & Eclipse Application HelloWorld
2 New_configuration

C/C++ Application:

a # FT9XX Application Run :
T TTOXX RUN FT900_Debug/HelloWorld.clf
Java AppIet

Variables.. | [Search Project.. | [ Browse.. |
(57 Java Application Build (i required) before launching
Ju Wik

Project:

34 JUnit Plug-in Test Build Configuration; [Use Active -
= Launch Group

@ 0SGi Framework ) Enable auto build ) Disable auto build
@ Use workspace settings

Downloading options
@ Load binary to flash memory

) Load binary to program memory

Configure Workspace Settings...

Revert Appl
Filter matched 12 of 12 items

Figure 32 Run Configuration window

[#] Prablems J=| Tasks B Console 22 | [C] Properties
CDT Build Cansole [Hello World]

16:4@:13 Build Finished (took 2s.58lms)

16:4@:13 Loading target device started...

Downleading binary...

C:/Program Files (x86)/Bridgetek/FT%o: Toolchain/Toolchain/programmer/dist/FT92@Frog. exe
Reseting device...

C:/Program Files (x86)/Bridgetek/FT%o: Toolchain/Toolchain/programmer/dist/FT92@Frog. exe

16:42:17 Loading Finished!

Figure 33 Console window after selecting launch configuration and clicking Run

Alternatively, the FT9XX Programmer can be accessed manually - either the GUI version or the
command line version.

3.3.2 GUI Version

To run it, double click on the icon “FT9XX Programming Utility” created on your desktop, if selected
during install, otherwise it can be found in:

C:\Program Files (x86)\Bridgetek\FT9xx Toolchain\Toolchain\programmer\dist

FT9
Frogrammin
 Utility

Figure 34 FT9XX Programming Utility Icon
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You can also open the programming utility from Eclipse by selecting it in the Bridgetek Utilities

menu or the toolbar icon as highlighted in Figure 35:

[ Bridgetek Utilities | Window Help
Ctrl+Alt+L

@ FT9:x Programming Utility

Figure 35 Bridgetek Utilities Menu

After the splash message the following screen will appear.

il N
4 FT9x Programming Utility C=mEel X
A Bridyetek
_ | 4 s
(@ Program via One-Wire interface
| () Program via USB (DFU) interface
I (") Add/Customize DFU-suffix (DFU binary)
|- ") Customize Bootloader file I
L R

Figure 36 FT9XX Programmer - Work with One-Wire

Only the option ‘Program via One-wire interface’ in this screen is covered in this section. For
information on the remaining options, please refer to the programmer utility help.

Select the “Program via One-wire interface” option and click Next. The next screen shows a list of

supported devices that you might wish to program.

When a valid FT9xx and Programmer module are detected, the information will be displayed in the
list. Select the device you wish to program and click Next to launch the programmer window.

% FT9x Programming Utility

[N

Interface

One-Wire

4 Bridgetek

FECANNLEET

Device

Programmer

Programmer Serial ...

Figure 37 FT9XX Programmer - Device Selection
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In the programmer window, leave everything as default. Specify the location of the binary file and
click Start. If the Verify check box is selected, an icon will show up next to the status bar to
indicate whether the flash memory has been properly programed.

% FTxx Programming Utility i = |
{Flzsh &P} p2xx | Data Log | About]|
!" -
Devie i Bridgetek
== et b
Interface Target
I One-Wire @ Flash T PM
|

Config Address {(hex)

[] verify [ Exdude bootioader [ Keep existing bootloader

Progress

|
|

Custom (@) Factory I I

Start Cancel I

i

L —

Figure 38 FT9XX Programmer - Flash and PM Screen

More information on the utility can be found in the ‘About’ tab, then click on Help.

3.3.3 Command Line Version

FT900Prog.exe is available to run at a command prompt. Enter FT900Prog.exe to see the options
available. See section 6.1.2 for more details.

This can also be run within Eclipse as an External Tool. See Figure 39 for settings found in Run >
External Tools - External Tools Configurations. The argument string is:

-f "${project_loc}\${config_name:${project_name}}\${project_name}.bin" -0 -v
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S External Tools Configurations =

Run a program

< 1

Filter matched 2 of 2 items

|/'-7\‘\

NG

Create, manage, and run configurations @

2% B>~ Name:  FT9x Program MTP
type filter text 5] Main " Refresh| [ Build| P Environment | (-] Common
4 Q@ Program Location:
@, FT9x«Program MTP C:\Pregram Files (x86)\Bridgetek\FT9xx Toolchain\Toolchain\programmer\dist\FT900Prog.exe
[BrowseWorksgace...] [Browsg File System...] [ Variables... ]
Working Directory:
[Browse Worl_(space...] [Browse File System‘..] [ Variables... ]
Arguments:
-f "${project_loc}\${config_name:${project_name}}\${project_name}.bin" -0 -v -

Note: Enclose an argument containing spaces using double-quotes (").

Figure 39 FT9XX Programmer in Eclipse

3.4 “Hello World” in action, and more...

The “Hello World” example above will send a message to a serial terminal via the FT9XX UARTO
port. Open a terminal on your computer, for example Tera Term or HyperTerminal. Apply the
following settings:

Baud Rate:
Parity Bit:
Data Bit:
Stop Bit:
Flow Control:

19200
None
8

1
None

Now when you reset the MCU, the message will be printed to the terminal.

@ FT90x - HyperTerminal SNACIE X
File Edit View Call Transfer Help
0= 2 DB

>Hello WYorld!

m

Figure 40 Hello World
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Congratulations! You have just completed your first project for FT9XX. The FT9xx toolchain comes
with plenty of examples, which demonstrate a variety of features. If you have selected to install
them in the Toolchain Installation Wizard, by default they can be found in:

"My Documents\Bridgetek\FT9xx\version\Examples”

The Eclipse project has already been setup for these examples, as suggested by the presence of
two files - “.cproject” and “.project”. Instead of creating a new project, you can simply import
these projects into the workspace. To do this:

On the Menu bar, choose “File > Import”

In the Import window, choose “General > Existing Projects into Workspace” and click “"Next”.
In the next window, set the root directory to "My
Documents\Bridgetek\FT9xx\version\Examples”. The projects will be detected by Eclipse.

4. Select which projects you wish to import and click Finish to complete the importing process.
This is an example of how Eclipse would look like with the sample applications. Refer to

AN 360 for more details about these applications.

W

£ C/C++ - GPIO Bxample 1/gpio_example1.c - Eclipse = bd
File Edit Source Refactor Navigate Search Project Run FIDIUtiliies Window Help
i [ B Rer N W TR B TO R G SO 3 e e Quick Access & | [EC/Cr ] 5 Debug
25 Project Explorer 52 A% ¥ = 8 | [g gpio_examplel.c 52 = 8 = Outline % =8
(5 ADC Example 1 49 #include <ft9ee.h> - SR e % v
(25 ADC Example 2 =@ u
G5 cam mmp‘el 51 #define STR(a) STR_(a) & stdinth
= i “‘ S 52 sdefine STR_(a) #a o0k
= smple - # STRQ
5 CAN Example 2 #define GPIO_PIN 18 # STRO
£ CAN Ersmple 3 # GPIOPIN
(5 DAC Example1 void setup(void); - )
5 pac Exam;\ez void loop(void); el ‘Sﬂ“:(w;?) D‘J
k + loop(void) : void
g DAC Example 3 int main(void) ®  main(void) : int
eth_ecample 1 ® setup(:void
4 (5 GPIO Bxampled setup(); @ loop{: void
4, Binaries for(;;) loap()
il Includes X return 0;
(& Debug
[£] gpio_examplel.c void setup()
(5 GPIO Example 2 {
5 GPI0 Example 3 Enable the USRT Device.
5 DC Master Bxample 1 sys_enable(sys_device - uarto);
= P fake GPIOAS function as UARTE_TXD and 510 function as UARTO_RXD.
(8 12C Slave Example 1 gpio_function(48, pad uarte_tsd); /* UARTO
% 125 Bxample 1 gpio_function(as, pad_uarte_rxd); /* UARTO. wx:
(25 125 Example 2 uart_open(UARTE, /
(5 PWM Example 1 L
UART_DIVIDER_19208_BAUD,
’@ PWM Bizmple 2 uart_data_bits &,
35 PUM Eample 3 uart_parizy none,
(5 RTC Bxample1 uart_stop_bits_1);
(5 RTC Bxample 2
5 5D Host Example 1 /* Print out a welcome message..
. uart_puts (UAS
’; SPIMaster Bample 1 T\x1B[23" VT186 - Clear the Screen */
5 SPIMaster Exarple 2 Rveriied 100 - Hove Curson to Home
& SPIMaster Bxample 3 "(C) Copyright 7014-2015, Future Technology Devices Intermational Lgd. \r\n"
(25 SPISlave Exemple 1 y
5 Timer Ecample 1 “lieleome to GPIO Example 1... \r\n"
ety
g:"‘”z“p:f "Toggle a pin on and off.\r\n"
imer Example . \rin
5 vart_eample 1 )5
(=5 uart_example_2
(5 uart_example 3 92 set up €
G Watchog Example o3 gpio_dir (apm P, pad_dir_output); -
) Console 52 C B EE K #E-O-=0

COT Build Console [GPIO Exemple 11

s
Fe32-elf-gec -LoC:/program Files (x86)/FTDI/FT90x Toolchain/Toolchain/hardware/1ib" -WL,--gc-sections -Wl,--entry=_start -o "GPTO Example 1.elf* ./gpio_examplel.o
‘Finished building target: GPI0 Example L.clf’

*Invoking: FT98x Flash File Generstor’
ft32-1f-1d --oformat binary "GPIO Example 1.elf” -o "GPIO Example 1.bin"
*Finished building: GPIO Example 1.bin’
*Tnvoking: FT9@x Display Image Size’
ft32-elf-size --format=berkeley -x "GPIO Example 1.e1f"
text  data bss dec hex filename
ox1396  0x206 @1 5527 1597 GPI0 Example 1.elf
*Finished building: SIZE"

14:22:36 Build Finished (took 1s.434ms)

4

(5 GPIO Example 1

Figure 41 FT9XX Examples
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4 Setting up Eclipse for Debugging

Eclipse comes with an intuitive GUI for debugging applications. To enable this feature, Eclipse
requires additional information about our debugger. The steps are presented below.

4.1 Build the application using the Debug configuration

The application should be built using the Debug configuration so that the debug information is
available. It is the default build configuration but can be verified in the Project menu.

ch | Project | Bun  Bridgetek Utilities  Window Help

& Open Project -~ @ - @D P - -
Close Project
ple_2_testing.c 3

o Build All Ctrl+B
Build Configurations » Set Active » | v 1FT900_Debug
Build Project Manage... 2 FT900_Release
i . ,
Build Working Set Build by Working Set , 3 FT930_Debug
£ Set Active by Working Set 3 BRI

v Build Automatically Manage Working Sets...

Figure 42 Build Configuration

Please note for FT93X: As of toolchain v2.3.0 it is recommended to disable the -mcompress
option when using GDB as single stepping does not work properly with -mcompress. The option can
be disabled in the project settings. See section 6.3.2.1 for more details.

4.2 Starting a debug session

The FT9XX toolchain components, including the FT9XX Programmer and FT9XX GDB Bridge, have
been fully integrated to the Eclipse IDE to allow seamless debugging experience.

To program the compiled binary file into the chip and start a debugging session, do the following:

1. On the Menu bar, select Run - Debug Configurations...

2. In the Debug Configurations window, expand the launch configuration type “FT9XX Application
Debug” and select the default instance “FT9XX DEBUG". This default instance will setup the
location of the ft32-elf-gdb.exe, connection type to “TCP”, host name to “localhost”, port
number to "9998"” as well as the project name and elf name.
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-
% Debug Configurations

==

! Create, manage, and run configurations

EI=E Name: FTOXX DEBUG
| B Main
[] C/C++ Application i T
[T] C/C++ Attach to Application
[£] C/C++ Postmortem Debugger HelloWorld

[T] C/C++ Remote Application
£ Eclipse Application
£ New_configuration

4 _FTOXX Application Debug
%_FT9XX DEBUG
Jeva Applet

C/C++ Application:
FT900_Debug/HelloWorld.elf

S

%5 Debugger| & Source| ] Commen

Build (if required) before launching

:

&

Browse...

Variables... | [search Project...| [ Browse.. |

[ Java Application
Ju WUnit

Build Cenfiguration: | Use Active

m

-]

J JUnit Plug-in Test () Enable auto build
B+ Launch Group
4 056i Framework

12l Remote Java Application

@) Use workspace settings

Downloading options

Advanced debug options

Filter matched 15 of 16 items

@

@ Load binary to flash memory

) Load binary te program memory

[ Display GDE bridge console

(7) Disable auto build

Configure Workspace Settings...

Revert Appl

Figure 43 Debug Configuration window

Click on the ‘Debug’ button to start the downloading and debugging. This will internally launch

the FT9XX Programmer application to program the binary and then launch the ft32-elf-gdb.exe
and FT9XX GDB Bridge to start the debugging session. The Console window will show the

progress of the download and debugging.

Q

Fun Last Launched

For succeeding debugging sessions, select Run > Debug Last Launched.

Ctrl+F11

#&, [ Debug Last Launched |

F11

Q-

Profile Histary
Prafile s

Profile Last Launched

Frofile Configurations..,

Fun History
Run &

Run Configuratians..,

Debug History
Debug &s

I Debug Configurations... I

Toggle Breakpoint

Ctrl+Shift+B

Toggle Line Breakpoint

Toggle Method Breakpaint

Toggle Watchpaint

Skip All Ereakpoints

Ctrl+2lt+B

Rermowe &ll Breakpoints

Breakpoint Types

External Tools

Figure 44 Debug Configurations and Debug Last Launched
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Problerns Tasks B Consale 52 Properties Debiug
CDT Build Consale [Hello World]
17:42:33 Build Finished (took 2s.581ms)

17:42:33 Loading target device started...

Downleoading binary. ..

C:fProgram Files (x86)/Bridgetek/FT%oc Toolchain/Toolchain/programmer/dist/FT9@@Prog. exe --loadflash
Reseting device...

C:fProgram Files (x86)/Bridgetek/FT%o Toclchain/Toelchain/programmer/dist/FT9@0Prog. exe --chipReset

17:42:38 Loading Finished!

17:42:38 Running GDB started...

Launching Debug Server (GDEB Bridge)...

python.exe “C:/Program Files (x86)/Bridgetek/FT%ot Tooclchain/Toolchainfutilitiesfgdb_bridge.py™ liwve
Launching Debug Client (ft32-elf-gdb)...

C:fProgram Files (x86)/Bridgetek/FT™oc Toolchain/Toolchainftools/bin/ft32-elf-gdb.exe

Figure 45 Console window after selecting launch configuration and clicking Debug

4.3 Debugging the application in Eclipse

1. Start the debug session as stated in the previous section.

2. The Debug perspective will be opened. The execution will stop at the first line in main(), as
shown below. Various debug commands (step into/over, resume, halt, stop, etc.) can now be
accessed from the toolbar via buttons. Function variables, setting breakpoints and viewing
physical memory in the memory tab, along with some other debug features are also available

now.
"
& Debug - Hello World/main.c - Eclipse Platfarm = | 5 ||
File Edit Source Refactor Mavigate Search Project Run  Window Help
== S R RS e S i HrO-@-®mEm v -9
L = - Quick Access |} B | [ Resource  Fg C/C++
45 Debug 52 [i% ¥ = B - Variables 2 =
4 [c] FT90x Remote Debug [C/C++ Remote Application] £ 5 ‘ ‘ et =
e |
a [ Hello World.elf
H ) X MName Type Value
4 % Thread #1 (Suspended : Breakpoint)
= main() at main.c:12 0:2f8
wi| Ci/Program Files (x86)/FTDI/FT90x Toolchain/tools/bin/ft32- T b
4 m 3 4 T
|| rainc &3 [ main.c = B 5= Outline &2 = a8
® * main.c - = laz& hks o %
#include <stdio.h> o sdioh

@ main{void) : int
int main(void)
1

m

printf{"Hello World!\n");

WRiTE (1);
return @;
} "
4 )
& Console &2 = |'.5;.“E| E||‘="E'.=J‘='E

FT90x Remote Debug [C/C++ Remote Application] C:/Program Files (x86)/FTDL/FT90x Toolchain/tools/bin/ft32-elf-gdb.exe (7.9.50.20150310)
Find the GDE manual and other documentation resources online at:
<http://www.gnu.org/software/gdb/documentation/>.

For help, type "help™.

Tvoe "apropos word” to search for commands related to "word". S
el

Writable Smart Insert 12:1

Figure 46 Eclipse Debug Environment
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Note: If there is an error message about missing source file as below, locate the source file that
contains the main() function using the “Locate file...” button.

Locate the file or edit the source lookup path to include its location.

View Disassembly...‘

Locate File...

Edit Source Lookup Path... ‘

Figure 47 Eclipse Missing Source File

4.3.1 Watch variables in Eclipse Debug Perspective

If the watch variables fail to update or display incorrect values, check that the following flags exist
for the debug build (they are present by default in all projects created with Bridgetek Eclipse
plugin)

-fvar-tracking -fvar tracking-assignments

Configuration: ll-—l'gﬂﬂ_[}ebug [ Active ] '] [Manage Configurations...

8 Tool Settings | Build Stepsl Build Artifactl Binary Parsersl @ Error Parsers|

(2 FTo Toolchain Settings | Debug Level | Default (-g) -
(# Target Board
(# FT32B Options

Other debugging flags  -fvar-tracking -fwar-tracking-assignments

4 B FTo GCC Compiler [ Generate prof information (-p)
(22 Dialect [] Generate gprof information (-pg)
(2 Preprocessor [] Generate gcov information (-ftest-coverage -fprofile-arcs)

(# Includes

(# Optimization
(¥ Debugging
(# Warnings

A moan "

Figure 48 Debug flags

4.3.2 Og Compiler Option when debugging

When compiling a project with no optimization (or —-O0) some useful debugging information may
not be generated at all, leading to possible unexpected results while debugging. To avoid this, it is
recommended to turn on -0Og option when no other optimization flags are used. The Bridgetek
Eclipse plugin does this automatically.

Note that if multiple optimization options are used, only the last option will be effective.
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Configuration: ’FFQUU_DEHUQ [ Active ] '] ’Manage Configurations...

& Tool Settings |.ﬁ" Build Steps Build Artifactl Binary Parsersl & Error Parsers|

@ FT9x Teolchain Settings Other optimization flags  -Og
(% Target Board
(# FT32B Options

4 B FT9oc GCC Compiler
53 Mialart

Figure 49 Og compiler optimization option

More information can be found in the GCC documentation -
https://gcc.gnu.org/onlinedocs/gcc/Debugging-Options.html and
https://gcc.gnu.org/onlinedocs/gcc/Optimize-Options.html

4.4 Eclipse features supported by ft32-elf-gdb

e The features of Eclipse debug perspective, supported through ft32-elf-gdb, are:Breakpoint
creation.

Single stepping/stepping in/stepping out of functions

Watch variables

Assembly instruction stepping

Memory View
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5 Bridgetek Projects

Besides the empty project used as the example in Section 3, there are several project types
specific to Bridgetek. They can be found under “Others” in the project type selection window.
Currently, there are three project types:

e D2XX Project
e Data Log (DLOG) Project
e FreeRTOS Project

For more details about these project types, refer to "AN 360 FT9XX Example Applications”, which
is included in the toolchain installation.

= C Project l S |-

C Project —

Create C project of selected type

Project name:  example

Uze default location

F\Users\richmondiworkspace2\example Browse...
default
Project type: Toolchains:
4 [= Executable = Bridgetek FTSe GCC

& Empty Project
@& Helle World AMSI C Project
» [= Shared Library
» [ Static Library
4 = Others
&> FTSao D2XX Project
» FT%o: Data Logger Project
<> FT90: FreeRTOS Project
» = Makefile project

m

-

Show project types and toolchains only if they are supported on the platform

@ < Back Next > Finish

Figure 50 Bridgetek Project Types
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The procedure to create a new project is similar to the empty project. When the wizard completes,
a template source file will be generated. The template generated for the D2XX project is given
below -

[.g] main.c lg] main.c &1 = 0
loop()s -

/* Event handling */
if (D2XXTEST_ DfuDetach)

delayms(18@);
f* DFU detach request had come. Exit D2XX *
D2XX_Exit();

* Take the system to DFU Mede. Provide timeout in ms teo
* wait for re-enumeration with the host

STARTUP_DFU(@);
break;

m

}

(* Suspend mode handling */
if (D2XXTEST_ Suspend)
{

wkupSource = @;

dbg("Entering Suspend Mede at Master \r\n™);
delayms(1@@);

#ifdef GPIO_REMOTE_WAKEUP

SetRemoteWakeup = @;

if (RemoteWakeupEnable)

dbg("Configuring GPIO pin to wakeup ‘rin");
#if 1
/* Set up the pin */
gpio_dir{GPIO_PIN, pad dir_ input);
gpio pull(GPIO_PIN, pad pull pullup);

* Attach an interrupt */
gpio_interrupt_enable(GPIO_PIN, gpic int_edge falling);
interrupt_attach(interrupt_gpio, (uint8_t)interrupt gpio, ISR gpio);
dbg("D2XXTEST: GPIO pin setup for interruptirin”);

#endif

#endif

4 [ 2

Figure 51 D2XX Project Template

The template project can be compiled as it is but additional code is needed to customize it
according to the user’s need.

After selecting the project template, the wizard also allows selection of add-on third-party libraries
that have been ported to work on FT9xx (see Figure 52). The source for the libraries are located in
<Installation directory>\Toolchain\hardware\3rdparty. Currently there are three third-party
libraries supported.

- Tinyprintf: A tiny/lightweight general purpose printf function that could be used to replace
the GNU library printf function.

- FatFs (based on version 0.12b): A FAT/exFAT filesystem module. FatFs accesses the
storage devices via a simple media access interface which the FT9xx application should
implement.

- IwIP (based on version 2.0.3): A lightweight TCP/IP stack for embedded device.
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= C Project

\ (5] [ |

Configure Compiler and Libraries

Configure the FT%a GCC path, GCC prefix and add-on libraries

FT%a compiler prefie ft32-elf-

FT%0c compiler path:  F:/Program Files (x86)/Bridgetek/FT%x Toolchain/Toolchain/tools/bin

[ tinyprintf (Small printf and sprintf library) Select all
FT%0¢ add-on libraries:

[ lwip (Light-Weight TCP/IP library)

Deselect all
[ fatfs (Generic FAT filesystem library)

Mext = [ Finish ] ’ Cancel

Figure 52 Add-on Libraries
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6 Advanced Topics

6.1 Running the Toolchain from the command prompt

6.1.1 Compiling the sample applications using a Makefile

The FT9XX GNU toolchain can be used to compile source code from a command prompt in the
same way the official GNU Toolchain is used, often with the help of a Makefile or a batch file.

The sample applications are available in “C:\Users\<User
name>\Documents\Bridgetek\FT9xx\<Tool chain version>\Examples\”, \ if you have installed
them using the installation wizard.

NOTE: makefiles are not included with the toolchain installer.

6.1.2 Programming a binary image into the chip

The programmer can be found in the folder “programmer\dist” in the program installation directory
(C:\Program Files (x86)\Bridgetek\FT9xx Toolchain). The command line programmer is
FT900Prog.exe. The Toolchain is provided with a default bootloader. The bootloader is located at
the top 4 KB of the flash memory (address 0x3F000 to Ox3FFFF). At boot, the FT9XX resets and
executes instruction at 0x00000, jumping into the bootloader. The bootloader then performs the
initializations needed and jumps to location 0x8c, which is the start of the user program. The
bootloader is also needed to support debugging with the FT9XX port of GDB.

1. Run the tool FT900Prog.exe without any arguments, the options and usage will be printed.
They will also be printed if the specified options are not valid. The most common usage is
programming a binary file through the one-wire interface with the supplied bootloader. To do
this, the command is:

FT900Prog.exe —f <.bin file with path if needed> -O
in which the options are:

-f: programming the binary file into the flash. The path to the binary file must follow.
-O: using the one-wire interface.

If you want to verify the content of the flash memory after programming, specify “-v” in the
command:

FT900Prog.exe —f <.bin file with path if needed> -O -v

2. If the bootloader is not required, option “-x" can be specified, in which case the program will
start executing from address zero and the command is:

FT900Prog.exe —f <.bin file with path if needed> -O -x

The supports for GDB debugging will not be available however.
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6.1.3 Debugging the sample applications with ft32-elf-gdb

1. The applications must to be compiled with —-g option (i.e. ft32-elf-gcc —g ...). An .elf file will be
created which includes the debug information, for example GPIO/gpio_examplel.elf. Note that
this file is not used for programming the chip.

Note: If the output file name for the linker is not specified in the Makefile (i.e. option -o is
missing), a.out will be created instead of an .elf file. They are the same and these steps can be
applied to a.out as well.

2. Flash the .bin file into the chip. Refer to section 5.1.2 above.
3. Open a command line window, run:

“python <Installation directory>\Toolchain\utilities\gdb_bridge.py live”

Note: An alternative is to double click on the shortcut “GDB Bridge” created after the
installation.

The correct response should be:

T — e o [ ]
F S e - = = = e

= - = e N

C:\Program Files (x86)>\Bridgetek\FIT%xx Toolchain\Toolchain\utilities>D2X¥¥ libhrar

y loaded OK

Figure 53 FT9XX Debugging Status

Note 1: If there is an error message about permission being denied, the command line
window may need to be opened with administrator rights by right-clicking and selecting ‘Run
as administrator’.

Note 2: It is also possible to run the GDB Bridge using the shortcut created after the
installation.

Note 3: If the path to gdb_bridge.py contains spaces, enclose it with double quotes (*”).

4. Open another command line window, go to the folder that includes the .elf file, run “ft32-elf-
gdb <.elf file>", for example “ft32-elf-gdb gpio_examplel.elf”.

5. After ft32-elf-gdb starts, type in “target remote localhost:9998” to establish a connection to
the MCU.

6. Use standard GDB commands to debug the program. Note that the command to start
execution should be “continue”, not “run”.

6.2 Installing Eclipse and the FT9XX plugin manually

When running the installer, it is possible to choose not to install Eclipse as part of the installation.
This might be useful if the user have already installed Eclipse for other purposes. This section
details how to set it up for use with the FT9XX.

6.2.1 Eclipse Installation

1. Go to Eclipse website, download “Eclipse IDE for C/C++ Developers”. At the time of this
writing, Eclipse Mars is the latest release and is the recommended version.
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Py | Windows
LY 166ME  1.144.540 DOWNLOADS
= 4 N -‘ﬂ ‘
The essential tools for any Java developer, including a Java IDE, a Git client,
XML Editor, Mylyn, Maven integration and WindowBuilder...
p Windows
-~
A 176 ME 443,358 DOWNLCADS 3
‘ > (] ‘
An IDE for {/C+ developers with Mylyn integration.
A Windows
— 244MB 297,100 DOWNLOADS 3
= = |
Package suited for development of Eclipse itself at Eclipse.
Windows
e 153MB  281.587 DOWNLOADS
@ . B |
The essential tools for any PHP developer, including PHP language support,
Git client, Mylyn and editors for JavaScript, HTML, €55 and...
Windows
_— 296 MB 170,553 DOWNLOADS =
- & \

The essential tools for Java and DSL developers, including a Java & Xtend
DE, a DSL Framework (Xtext), a Git client.

Figure 54 Eclipse Versions

2. When Eclipse is run for the first time, it will ask for the workspace location.

"
= Workspace Launcher @

Select a workspace

Eclipse stores your projects in a folder called a workspace,
Choose a workspace folder to use for this session,

Workspace: - Browse...

[ Use this as the default and do not ask again

Figure 55 Eclipse Workspace Location

A workspace is a directory on the hard drive where Eclipse stores the projects defined to it.
More specifically, a workspace is a logical collection of projects. When you specify this
directory name to Eclipse, Eclipse will create some files within this directory to manage the
projects. The projects controlled by this workspace may or may not reside in this directory.
Specify a directory name and click OK.

Note: To run Eclipse, it is required to download and install the Java Run Time Environment
(JRE) or Java Developer Kit (JDK). Eclipse should display a warning if this is not installed.
Oracle provides these tools for free.
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6.2.2 FT9XX Eclipse Plugin Installation

To assist with completing the configuration of Eclipse for FT9XX coding an extra plug-in is provided
as part of the download. To install the plug-in, the following steps are required:

1. From the Eclipse toolbar select Help -> Install New Software which will pop up the window as
below.

Available Software
D =

Check the items that you wish to install.

Work with:  Bridgetek - file: ‘com.ftdichip.ft90x/ A Add...
Find maore software by working with the "Available Software Sites” preferences.
type filter text

Mame Version
- [¥] 000 Bridgetek FT9x Eclipse Plugins

Select Al | [ Deselect Al
Details
Show only the latest versions of available software Hide itemns that are already installed
Group items by category What is already installed?
[] Show only software applicable to target environment I

Contact all update sites during install to find required software

@ < Back Next > e
Figure 56 Eclipse Plugin Setup Wizard

2. Select the ADD button, and browse to the LOCAL location of the folder ‘com.ftdichip.fto0x’
which can be found in “Toolchain\eclipse plugins” in the toolchain installation directory.

3. Press “SELECT ALL” followed by NEXT to install the plugin

4. Close the window when complete.

6.3 Common project settings in Eclipse

6.3.1 Include paths

Eclipse uses its built-in indexer to resolve dependencies between files. In order for the indexer to
work correctly, paths that contain the header files in the project need to be added as follows:

1. Right-click on the project and select Properties
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2 C/C++ - FT90x_Examples/GPIO/gpio_examplel.c - Eclipse
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Figure 57 Eclipse Project Properties

In the Properties window, select C/C++ General > Paths and Symbols
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Figure 58 Eclipse Paths and Symbols

dow

Under the Includes tab, choose "GNU C"” under Languages, then click “Add...” on the right

In the “Add directory path” window, specify the path to the folder that contains the header

files. If the same path is used for some C++ files, check the box “Add to all languages”,

then click OK.
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B " Add directory path

Directory:

[] Add to all configurations
[] Add to all languages
[[] = Is a workspace path

Figure 59 Eclipse Add Directory Path

Note: The paths should be added one at a time. The use of semicolon is not supported.

6.3.2 Toolchain settings

The FT9XX toolchain supports most GNU toolchain options. To specify an option that is not
included by default, for example to create a map file, do it as follows:

1.

2.

adjusted in the Settings window.

Right click on the project and select Properties
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In the Properties window, select C/C++ Build > Settings. The toolchain settings can be

Figure 60 Eclipse T

oolchain Settings
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6.3.2.1

FT32B options (only for FT93x)

The FT93X target has two special compiler options -mft32b and -mcompress. -mft32b enables the

FT32B instruction set and -mcompress enables code compression, which can typically result in a

type filter text

: Resource
Builders
a C/C++ Build
Build Variables
Environment
Legging
Settings
Tool Chain Editor
. C/C++ General
Linux Teols Path
Project References

Settings

- v w

Configuration: ’ FT920_Debug

'] ’ Manage Configurations...

&) Tool Settings | #* Build Steps |

Build Artifactl Binary Parsersl @ Error Parsers|

(28 FT%x Toolchain Settings

(2 Target Board
(% FT32B Options
4 B FT9a GCC Compiler

FT32B Instruction Set (-mft32b)
Code Compression (-mcompress)

Figure 61 FT32B options (for FT93X)

6.3.3 C/C++ Indexer Settings

For Eclipse syntax highlighting to work correctly as you switch configurations, the Indexer has to
be configured to work with the active build configuration as shown in Figure 64. This is a
workspace specific setting and can be accessed in Eclipse via Window | Preferences | C/C++ |

Indexer

Figure 62 Configure Eclipse indexer to use the active build configuration

LS
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- Help
> Install/Update
> Library Hover
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v
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: Run/Debug
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code size reduction of about 20 - 30%. These options can be updated in the toolchain settings as
shown in Figure 61. Note that this option is only available in the FT930_* configurations.
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6.3.4 C++ Compilation

C++ compilation is supported; however there is no support for the standard C++ libraries or STL
libraries. Some language features are also not supported, e.g. new and delete operators. Include
files of FT9xx libraries are C++ safe when wrapped in extern “"C” {} scope in order to be excluded
from the C++ namespace. Constructors and destructors of singleton classes are not supported and
will require the programmer to supply his own crt0.s file. Support for global and static objects shall
be added in a future version.

6.4 FreeRTOS Kernel-Aware Debugging

FT9XX supports the popular real-time operating system, FreeRTOS. FreeRTOS allows creation of
tasks, queues, events, semaphores, mutex and timers for inter-task communication and
synchronization. To help debug these kernel objects, the FT9XX Eclipse plugin has been updated to
provide custom views to list the FreeRTOS kernel objects.

These views can be opened via the menu Window > Show View > Others > FreeRTOS.

= Show View

type filter text

s = Ant -
o = APITools

s GG+
= Charts

s = Connections

m

> = Debug

: [ DSF Exarmples

4 | FreeRTOS
@ FreeRTOS Configuration
# FreeRTOSHeap Usage
@ FreeRTOS Queues
@ FreeRTOS Tasks
@ FreeRTOS Timers

= General

= Git

Cancel

6.4.1 FreeRTOS views

The views will show the kernel objects that have been created at the point where the application is
suspended, that is, when a breakpoint has been triggered.

These views allow the user to do the following:

save the table of values to a CSV file
clear the table

refresh the table

sort the table by the selected column

A tooltip description is also provided for each column of the views for a description of the column
values.

For a demonstration of these views, refer to "FreeRTOS Example 4" application.
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6.4.2 FreeRTOS Tasks view

This view displays the tasks that have been created. Each task has the following properties: task
control block (TCB#), name, address, priority, state, start of stack, top of stack, total stack usage,
event object and runtime percentage.

Note that deleted tasks will appear in this view with state ‘DELETED’. These tasks will disappear in
the view only when the idle task has freed up the corresponding memory allocation.

[© workspace - Debug - Eclipse N =

File Edit Mawvigate Search Project Run  Window Help

il |@is | ® M 3 @R s Q- Q@O A A s e,
E B Consale Jo Tasks |* Problems @3 Executables [J Mermory @ FreeRTOS Tasks 52 FreeRTOS Queues " FreeRTOS Tirners @ FreeRTOS Heap Usage
D Task TCé# Task Marme  Task Address  Task Priority  Task State  Task Stack Start  Task Stack Top  Task Stack Usage  Task Event Object  Task Runtime

Printd 0:00001d3c 1 READY 000000434 0:00001cad 3052 Maone 0,002

& 2 Printl 000002 cda4 1 READY 000001d9 000002d0c 3052 Maone 0.00%

|3 Print2 000003 el 2 READY 00000204 000003d74 3052 Maone 0.00%

4 Print3 000004674 3 READY 000003efic 000004ddc 3052 Maone 0.00%

5 Printd 000005ed: 4 READY 00000 4ed4 000005244 3052 Maone 0.00%

fi Prints D0 0006F44 5 READY 000005F3c 000006eac 3052 Maone 0.00%

7 Printf 000007 fac fi READY 00000 6f24 000007F14 3052 Mone 0.00%

g Print? 000008014 7 RUMMING D0000800c 0000087 c 3052 Maone 0.00%

q IDLE 000008b10 0 READY 000009708 000009278 a0 Maone 0.00%

10 Tenr Swe D0 0009F78 1 BLOCKED 000009670 000009ec0 242 000009464 100.00%

Figure 63 FreeRTOS Tasks view

Some of these properties are dependent on a configuration in “FreeRTOSConfig.h". If these macros
are set to 0, “Unknown” value will be displayed. Refer to the table below for these dependencies.

Table 1 FreeRTOS Tasks macro dependencies

FreeRTOS Task Property FreeRTOS Configuration macro
Task TCB# configUSE_TRACE_FACILITY
Task Runtime configGENERATE_RUN_TIME_STATS

6.4.3 FreeRTOS Queues view

This view displays the queues that have been registered. Each registered queue has the following
properties: name, address, type, maximum length, item size, current length, #tx waiting and #rx
waiting.

[ workspace - Debug - Ecipsc 1 ——

File Edit Mawigate Search Project Run  Window Help
i |u10§\Q|IJD‘ @&33&.":v.u'i|i=€> ﬁvav%v@b“q)v - L= -
= & Console =) Tasks |[* Problerns (2 Executables [J Mernory @ FreeRTOS Tasks & FreeRTOS Gueues 50 & FreeRTOS Timers & FreeRTOS Heap Usage
m Queue N;me Queue Address Queue Type Queue Max Length  Queue Item Size  Queue Current Length  Queue # T Waiting  Queue # Rx \iaiting
00000918 Counting Sernaphare 4 1] 1 1] 0
= 52 000009220 Counting Sernaphare 5 1] 0 1] 0
7%? 53 0=00009278 Counting Sermaphaore f 1] 1 1] 0
C54 D000092d0 Counting Sermaphaore 7 1] 0 1] 0
M1 000009328 Mutes 1 0 1 0 0
k2 000009380 Putesx 1 0 1 0 0
k3 00000938 Putesx 1 0 1 0 0
e 0:00000cdc e 1 0 0 0 0
a1 000009074 Queue 1 5 0 0 0
Q2 000009014 Queue 2 10 0 0 0
3 000009140 Queue 3 15 0 0 0

Figure 64 FreeRTOS Queues view
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Some of these properties are dependent on a configuration in FreeRTOSConfig.h. If these macros
are set to 0, “Unknown” value will be displayed. Refer to the table below for these dependencies.

Table 2 FreeRTOS Queues macro dependencies

FreeRTOS Queue Property FreeRTOS Configuration macro
Queue Type configUSE_TRACE_FACILITY

6.4.4 FreeRTOS Timers view

This view displays the timers that have been created. Each timer has the following properties: id,
name, address, period, reload and callback function.

[ workspace - Debug - Ecipse N —

File Edit Mawigate Search Project Run  Window Help

Mg | @ s |00 ® & 2w e Q- Qi@ E il
= & Console J=| Tasks |'_ Problerns 00 Executables  [J Mernory @ FreeRTOS Tasks @ FreeRTOS Queles
i} TimerID1 Tirmer Marme Tirmer &ddress  Timer Period  Tirmer Reload Timer Callback
oD 1 OneShat 000009430 1000 Off TimerCallbackOneShot
& Q000onoonz Oneshot? M00009524 1000 Off TirmerCallbackOneshot
Uﬁs: Q00000003 Oneshot3 D=0000956% 20000 Off TimerCallbackOneshat

00000004 Oneshotd M=0000959¢ 30000 Off TimerCallbackOneshat
Q00000005 Oneshoth 000009540 40000 Off TimerCallbackOneshot
000000006 AutoReload 000009604 5000 Auto TirmerCallbackAutoReload
Nx00000007F AutoReload? 0x00009638 100000 Auto TimerCallbackautoReload
N=00000008 AutoReload3 00000966 200000 Auto TimerCallbackAutoReload
N=z000000049 AutoReloadd 0x000096a0 300000 Auto TimerCallbackAutoReload
00000000z AutoReloads 000009644 400000 Auto TirmerCallbackAutoReload

Figure 65 FreeRTOS Timers view

6.4.5 FreeRTOS Heap Usage view

This view displays the current heap allocations or usage. Each heap block has the following
properties: type, base address, end address, total size and available size.

5 worpce oo —

File Edit Mawigate Search Project Run  Window Help
Y~ | @ w0 m m M 3D R v Q- Q@O Pl

=
[ || Heap Type Heap Block Base Address  Heap Block End Address  Heap Block Size  Heap Block &wailable Size

Heap 4! T00000cce 0:00003Fd0 ERLE] 1]

7 Hepd  bAOOSRd0  GdOO0dec a6 s

Figure 66 FreeRTOS Heap Usage view

El Console J=| Tasks |"_ Problerns @3 Executables [J Memory & FreeRTOS Tasks & FreeRTOS Queues 7 F

The heap type value can be changed via the preprocessor symbol FT32_PORT_HEAP.
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6.4.6 FreeRTOS Configuration view

This view allows the user to configure the FreeRTOS configuration macros located at
FreeRTOSConfig.h. The user can modify FreeRTOSConfig.h directly or via this view.

[ wortspace - Debug - Ecipse I —

File Edit Mavigate Search Project Run  Window Help

config TICK_TIMER_CHAMMNEL
config TICK_TIMER_PRESCALER
configCPU_CLOCK_HZE

config TICK_RATE_HZ

config TOTAL_HEAP_SIFE
configUSE_MALLOC_FAILED_HOOK
confighIMIMAL_STACK_SLZE
confighd&x_PRICRITIES

:=?v |nm§\®.| ol | #}:Vev%vgb Q;"E e M=
5 Bl Console J=| Tasks [2] Problerns (20 Executables @ FreeRTOS Configuration 52 | @ FreeRTOS Tasks 4 FreeRTOS Queus
| hacro Yalue
<o | [ DPrintf tp_printf
= MHz (10000003
?f’; SWECLE (unsigned long)100*MHz)

tirmer_select_a)

a0

(unsigned long)(SYSCLK f configTICK_TIMER_PRESCALER))
((TickType_t)1000)

((size_th(50* 10243

0

({unsigned short)2*128)

10

configllSE_PREERPTION

configll SE_IDLE_HOOK,

configl SE_TICK_HOOK,
configllSE_16_BIT_TICKS

configll SE_APPLICATION_TASK_TAG
confighlUM_THREAD_LOCAL_STORAGE_POIMTERS
configllSE_RECUREIVE_MUTEXES
configll SE_MUTEXES

configl SE_COUNTING_SEMAPHORES
configl SE_ALTERMATIWE_API
configU3E_TIMERS
configQUEUE_REGISTRY_SIZE

[ e - ="

[y
-

Figure 67 FreeRTOS Configuration view

The values in the table appear when the application is not running. Once the application is running,
it is not possible to update the values.

To change a value, just select the value and change. Any changes in it will be highlighted in
yellow. To save the changes, click on the save button at the top right corner of this view. This will
overwrite the existing configuration file FreeRTOSConfig.h. A backup of the original file will be
saved in the same directory.

When overwriting the configuration file, this feature preserves the code comments and
whitespaces and also supports macros, multi-line macro definitions and macros enclosed in #ifdef
#if defined.

6.4.7 Built-in Debug view

The built-in Debug view has been customized to show the list of FreeRTOS tasks that have been
created. Each task indicates its TCB number, name and current state.

Currently, only the running task displays a function call stack. The top frame of the running task
call stack will always be selected automatically. In case no frame is selected, user must select a
frame before doing a debug command (continue, step into/over/return, etc).

Note that deleted tasks will appear in this view with state ‘DELETED’. These tasks will disappear in
the view only when the idle task has freed up the corresponding memory allocation.
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File Edit Source Refactor Mawvigate Search Project Run  Window Help
|=?" |um§\Q|UP @&3‘3}.“:1?-Uf|i=& %?“YO'%"@@[D C'J"E

E %5 Debug &2
i a % FTROCDEBUG [FTEX Application Debug]
4 12 Free RTOS Exarnple 4.elf
o Task #1 [Print0] (READY)
o Task #2 [Printl] (READY)
o Task #3 [Print2] (READY)
o Task #4 [Print3] (REALY)
o Task #5 [Printd] (REALY)
o Task #6 [Print5] (READY)
o Task #7 [Printd] (READY)
a g Task #8 [Print7] (RUMNING)
preMewPrintstring () at free_rtos_exarmpled,ci623 0x46c8
prePrintTask() at free_rtos_exampled.ciB67 0x4708
= (Oxdeadheef
o Task #9 [IDLE] (READY)
o Task #10 [Trmr Swc) (BLOCKED)
w| CiPrograrm Files (<B6)/Bridgetek/FT % Toolchain/Toolchainftools/binfft32-elf-gdb.exe {8.0.50.20170905)

Figure 68 Built-in Debug view

The FreeRTOS configuration macro configUSE_TRACE_FACILITY must be set to 1 in
FreeRTOSConfig.h for this view to display all the tasks created. Otherwise, only 1 task will be
displayed.
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7 Troubleshooting

This section documents the problems you may encounter when using the FT9XX Toolchain.

7.1 Makefile error

If using a makefile to build an application, some makefile errors may be reported, for example:

EX Command Prompt |i|ﬂlﬂ—hj

A A A A LA
mmmmrmm

nd

Figure 69 Makefile Error

This is usually because some existing toolchain on the system may be using its own “make” utility
which is also referred to in the PATH variable. The FT9XX examples need to be built by the
GnuWin32 “make” utility, which can be installed during the toolchain installation. To solve this
problem, adjust the PATH variable so that the correct "make” utility is called by the toolchain. Note
that it may be necessary to adjust PATH again for the other toolchain. Type “where make” in a
command prompt to find out which “make” utilities are present on the system.

BN Command Prompt |£|EI&J

Figure 70 "make” Locations
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7.2 Programming does not work for either RUN or DEBUG

1. Ensure that manually-executed FT900 Programmer and GDB Bridge are not running. The
new Eclipse plugin automatically runs the FT900 Programmer and GDB Bridge so user
does not need to manually run these applications anymore. These applications will fail to
run if there are other instances running because they both share the one-wire
programming interface.

2. Ensure that Eclipse-executed GDB Bridge is not running. This Eclipse-executed GDB
Bridge is launched without a visible window. Check Task Manager and kill the process.

File Options View Help

|.n\ppl\caﬁur|s| Processes ‘Seruices IPerfurmance | MNetworking IUsers |

Image Narge Image Path Name Command Line i
pceed.exe C:'\Dolby PCEE4\pceed...  "C:\Dolby PCEE4\pceed.exe” -autostart
i python.exe *32 Fr\Python27\python.exe  python.exe “F:/Program Files (x86) Bridgetel/FT%ux Toolchain Toolchain/utiities fadb_bridge.py” live:

RAVBg64 exe F:\Program Files\Realt...  F:\Program Files\RealtekAudio\HDA\RAVBgE4.exe”™ [FORPCEES

RAVCpI&4.exe F:\Program Files'\Realt...  F:\Program Files\RealtekAudio\HDA\RAVCDIE4.exe”™ -5

Skype.exe *32 F:\Program Files (x86)\... F:\Program Files (x86)\Skype\Phone\Skype.exe” /minimized fregrun

| SkypeBrowserHost.... F:\Program Files (x86)\... “F:\Program Files (x86)\Skype\Browser\SkypeBrowserHost.exe” Embedding
SkypeBrowserHost.... F:\Program Files (x86)\...  "F:\Program Files (x86)\Skype\Browser\SkypeBrowserHost,exe” Embedding

starter.exe *32 F:\Program Files (x86)%...  F:\Program Files (x88)\Bridgetek \FT9xx Toolchain\Toolchain\edipse\pluginsiorg. edipse.cdt. core win32.x86_5.4. 1,

taskhost. exe F:\Windows\System32\... “taskhost.exe”™

taskmagr.exe F:\Windows\System32\... F:\Windows\system32\taskmar.exe” /4

ttermpro.exe *32 F:\Program Files (x86)\... F:\Program Files (x86)\teraterm-4.96\ttermpro.exe™ E

VCDDaemon.exe *32  Fi\Program Files (x86)\...  "F:\Program Files (x86)\Elaborate Bytes\VirtualCloneDrive \WCDDaemon, exe” fs

winlogon.exe

WLTRAY .EXE F:\Program Files\Broad...  F:\Program Files\Broadcom'\Broadcom 802. 11 Network Adapter WLTRAY EXE™ -

< T 3

| ‘[‘_g'shaw processes from all users | End Process

Processes: 81 CPU Usage: 0% Physical Memory: 33%

Figure 71 Eclipse-executed invisible GDB Bridge

7.3 Build errors due to anti-virus software protection

When building in Eclipse, the build process will sometimes stop or get delayed with the messages
like:

make: *** Access is denied.
Stop.
make: *** Waiting for unfinished jobs....
Or
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AVG

Hang on,--
this file may contain something bad.

C:\Program Files (x86)\Bridgetel\FT%e Toelchain,
Teolchain‘tools\bin\ft32-elf-chjcopy.exe

3

We're running a quick 15 second scan to see if we can
identify any malware

Abort

Figure 72 AVG warning during building in FT9xx toolchain

This is a known issue with some antivirus software, such as AVG.
Workarounds include (depending on the antivirus software):

- Temporarily disable the antivirus software.

- Add exceptions to every "exe/bat" under the FT9xx Toolchain folder.
In case of taking exceptions in AVG Business, refer to the following link -

https://support.avg.com/SupportArticleView?|=en&urlname=Excluding-Files-from-Scanning-in-
AVG-Business-Products
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-

AVG AVG Business

O Scan for potentially unwanted applications (PUAs)

General
Silent Mode €

Components Enable AVG email signature

Update
Popups

Shbear
ubscription Password

Troubleshooting Maintenance

Exceptions
Remote Admin

Type Paths and URLs to be excluded from scanning and from all shield protection. Be careful when modifying these exceptions as

any mistake might put your PC at risk.

File paths Urls CyberCapture
C:\cygwin64\bin\perl.exe
Z\ApplicationTeam\_HW SW Tools\Lecroy\Conquest7.41\autorun.exe

C:\Program Files (x86)\Bridgetek\FT9x Toolchain\Toolchain\tools\*

Cancel

Figure 73 Adding exception in AVG for FT9xx toolchain executables

7.4 Building of header files from Eclipse Virtual Store

If the FT9xx toolchain is installed in the system directory path ‘C:\Program Files
(x86)\Bridgetek\FT9xx Toolchain’, when Eclipse IDE of FT9xx Toolchain is not run in administrator
mode, and when the library header files also under system directory path ‘C:\Program Files
(x86)\Bridgetek\FT9xx Toolchain’ are modified by the user in eclipse editor, the files get actually
saved in C:\Users\%Username%\AppData\Local\VirtualStore\Program Files (x86)\Bridgetek\FT9xx
Toolchain\. This is because Eclipse sees the files it changed in C:\Program Files
(x86)\Bridgetek\FT9xx Toolchain, but other applications like the Windows Explorer will see only
the unchanged files.

If the above behavior adds confusion to the building of eclipse projects, then,

The User can choose to install the toolchain in a non-system path so that the FT9xx library
header files are also installed in non-system path

Or

Run the eclipse IDE with elevated privilege mode by selecting ‘Run as administrator’ while
opening the eclipse.

Or

Clear the Virtual Store path (C:\Users\%Username%\AppData\Local\VirtualStore\Program
Files (x86)\Bridgetek\FT9xx Toolchain\) for any stale headers.

More info about Virtual store can be found in the below link:

https://answers.microsoft.com/en-us/windows/forum/windows 7-windows programs/please-
explain-virtualstore-for-non-experts/d8912f80-b275-48d7-9ff3-9e9878954227
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Tel: +44 (0) 141 429 2777

Fax: +44 (0) 141 429 2758

Branch Office — Taipei, Taiwan

Bridgetek Pte Ltd, Taiwan Branch

2 Floor, No. 516, Sec. 1, Nei Hu Road, Nei Hu District
Taipei 114

Taiwan, R.O.C.
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risk, and the user agrees to defend, indemnify and hold harmless Bridgetek from any and all damages, claims, suits or expense
resulting from such use. This document is subject to change without notice. No freedom to use patents or other intellectual
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Appendix A - References

Document References
http://brtchip.com/m-ft9/

AN_360 FT9XX Example Applications
TN _160 Eclipse Projects

Acronyms and Abbreviations

Terms Description
CMD Command-line interface
DLL Dynamic-link Library
DLOG Data Log (Project)
GAS GNU Assembler
GCC GNU Compiler Collection
GDB GNU Project Debugger
GNU GNU (Gnu’s Not Unix) Operating System
GUI Graphical User Interface
IDE Integrated Development Environment
JDK Java Development Kit
JRE Java Runtime Environment
MCU Microcontroller Unit
PATH PATH Environment Variable
TCP Transmission Control Protocol
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